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Che cosa c'é di nuovo

Che cosa c'é di nuovo nel software Tl Connect™ CE v. 5.4.0
Uscire dall’impostazione Exam Mode (Modalita esame) sulle calcolatrici CE collegate

Uscire dall'impostazione Exam Mode (Modalita esame) sulla CE collegando le
calcolatrici CE al computer e selezionando

e Operazioni > Esci da modalita esame su collegato calcolatrici CE in T| Connect™ CE.

Promemoria: Utilizzare il Bundle CE piu recente disponibile presso
education.ti.com/84ceupdate per essere certi di disporre sulla CE dei file della
calcolatrice piu aggiornati e appropriati per la TI-84 Plus CE.

Per ulteriori informazioni sulle funzionalita nuove e aggiornate, andare all'indirizzo
education.ti.com/84ceupdate.

Che cosa c'é di nuovo
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Introduzione al software Tl Connect™ CE

Il software Tl Connect™ CE semplifica e velocizza lo scambio di dati tra la calcolatrice
grafica e il computer.

Supporta tutte le calcolatrici grafiche TI-8x che dispongono di una porta USB, che
includono:

e TI-84 Plus CE

e TI-84 Plus CE-T

e TI 84 Plus CSilver Edition

e TI-84 Plus

e TI-84Plus T

e TI-83 Premium CE Edition Python* & TI-83 Premium CE
e TI-83 Plus.fr

e TI-82 Advanced

*Nota: La TI-83 Premium CE Edition Python e la TI-83 Premium CE verranno entrambe
visualizzate come TI-83 Premium CE.

Nota: Utilizzare Tl Connect™ 4.0 per supportare calcolatrici che dispongono solo di una
porta I/0:

e TI-83 Plus

e TI-89 Titanium
e Voyage™ 200

e TI-73 Explorer™
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Utilizzo del software Tl Connect™ CE

Il software Tl Connect™ CE contiene gli strumenti necessari per scambiare dati tra la
calcolatrice e il computer.

File  Edit  View  Actions  Help

=

[0} CONNECTED CALCULATORS (1)

[ @ -84 Plus CE
|E 0553

Press [8] to capture calculator screens

Il software Tl Connect™ CE dispone di tre aree di lavoro:

e Screen Capture (Acquisizione schermata): consente di gestire le schermate
acquisite

e Calculator Explorer (Gestione calcolatrice): consente di gestire il contenuto della
calcolatrice

e Program Editor (Editor di programmi): consente di lavorare con programmi Tl-Basic
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Elementi del software Tl Connect™ CE

2 TI Connect™ CE i [=]E3]
File  Edit  View  Actions  Help
CONNECTED CALCULATORS (1)
M % T84 Plus CE
E 0553
(]
@ e @ Press [8] to capture calculator screens

o Barra dei menu - Utilizzare questi menu per gestire i file e le schermate della
calcolatrice, per visualizzare i dati della calcolatrice e per ottenere aiuto.

File Edit View Actions Help

e Barra degli strumenti - Utilizzare queste icone per gestire i file e le schermate
del computer.

@ Pannello Aree di lavoro- Utilizzare questo pannello per selezionare le aree di
lavoro: Screen Capture (Acquisizione schermata), Calculator Explorer (Gestione
calcolatrice) e Program Editor (Editor di programmi).

=

IEl

o Pannello Elenco calcolatrici - Utilizzare questo elenco per vedere tutte le
calcolatrici collegate e selezionarne una per la visualizzazione.
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CONMECTED CALCULATORS (1) @
TI-84 Plus CE
2 [ @

@ Pannello Contenuto - Utilizzare questo pannello per visualizzare e gestire i file
e le schermate della(e) calcolatrice(i) collegata(e).

File  Edit  View  Actions  Help

B 8 8 1 &

CONNECTED CALCULATORS (1)

E TI-84 Plus CE <
B B

Nota: E possibile eseguire la maggior parte delle azioni di questi menu
trascinando e rilasciando elementi sulla calcolatrice o il computer collegato.
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Utilizzo dell'area di lavoro Screen Capture (Acquisizione
schermata)

L'area di lavoro Screen Capture (Acquisizione schermata) consente di gestire le
schermate acquisite dalla calcolatrice.

e

File  Edit  View  Actions  Help

=] | o ® 7 100%

*Capture 1 X
(o)  CONNECTED CALCULATORS (1)

B @ TI-84 Plus CE
|E 0553

*Capture 2 X

NORMAL FLOAT AUTO REAL RADIAN MP n

CHLCULRTE!
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Elementi dell'area di lavoro Screen Capture (Acquisizione
schermata)

Barra dei menu - Utilizzare questi menu per gestire i file e le immagini, per
visualizzare i dati della calcolatrice e per ottenere aiuto.

File Edit View Actions Help

Nota: E possibile eseguire la maggior parte delle azioni di questi menu trascinando
e rilasciando elementi dal pannello Contenuto.

Barra degli strumenti - Fare clic su queste icone per salvare, inviare, copiare, eliminare
e ridimensionare file.

[ 100%

Salva un file sul computer.

Invia un file alla calcolatrice.

Copia un file.

Elimina un file.

Aggiunge o rimuove un bordo da tutte le schermate acquisite.

Modifica le dimensioni di tutte le schermate acquisite.

N Noul~ o o

Visualizza le dimensioni di acquisizione della schermata.

Pannello Contenuto - Visualizza le schermate acquisite.

*Capture 1 X
NORMAL FLOAT AUTO REAL RADIAN MP 1]
|
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Acquisizione e utilizzo di schermate

Nell'area di lavoro Screen Capture (Acquisizione schermata), € possibile acquisire e
visualizzare schermate dalla calcolatrice.

Prima di cominciare

Collegare la calcolatrice al computer e accertarsi che sia visualizzata nel pannello
Elenco calcolatrici.

Per acquisire schermate della calcolatrice

1. Nel pannello Aree di lavoro del software Tl Connect™ CE, fare clic sull'area di
lavoro Screen Capture (Acquisizione schermata).

2. Sulla calcolatrice, visualizzare la schermata da acquisire.

3. Fareclicsu accanto alla calcolatrice desiderata nel pannello Elenco
calcolatrici.

e Se sono collegate piu calcolatrici, fare clic su @ accanto a CONNECTED
CALCULATORS (CALCOLATRICI COLLEGATE) per acquisire schermate da tutte le
calcolatrici.

Salvataggio di schermate della calcolatrice come file

L'area di lavoro Screen Capture (Acquisizione schermata) consente di salvare immagini
acquisite o esistenti dalla calcolatrice come file PNG.

*Capture 1 x
1]

NORHAL

FLOAT AUTO REAL RADIAN HP

Nota: L'asterisco all'inizio del nome di un'immagine indica che I'immagine non &
salvata.

Per salvare una schermata esistente

1. Fare clic sulla schermata acquisita nel pannello Contenuto.

2. Fareclicsu .

Per salvare piu schermate contemporaneamente

1. Fare clic su Edit > Select All (Modifica > Seleziona tutto).

2. Fareclicsu .
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Per rinominare una schermata acquisita

1. Posizionare il cursore all'inizio del campo del nome della schermata.
Ad esempio: Capture 1.

2. Fare doppio clic sul nome per selezionarlo.
3. Digitare un nuovo nome per il file del computer.
Per salvare una nuova schermata acquisita come file PNG

1. Fare clic sull'immagine.

Fare clic su .

Evidenziare la posizione desiderata per il salvataggio.

4. Utilizzare il nome file predefinito oppure utilizzarne uno nuovo.

.
5. Fareclicsu .

Per inviare schermate acquisite a calcolatrici collegate

Questa sola funzione di acquisizione schermata consente di catturare I'immagine di un
grafico sullo schermo nelle calcolatrici ad alta risoluzione, tagliare I'area del grafico e
quindi convertire solo I'area del grafico in un'immagine di sfondo. Selezionare Graph
Area Only (Solo area del grafico) per creare questo tipo di immagine di sfondo.

1. Se ancora non é stato fatto, acquisire la schermata.

2. Fare clic sull'immagine acquisita per selezionarla.

b
3. Fareclicsu

& send to Calculators x|

FILE NAME: NAME ON CALCULATOR: LOCATION: I

Capture 2 Image1 v \/

Screen captures and converted image files will be sent as Pic Vars to black and
white calculators

DESTINATION CALCULATORS: [_] Graph Area Only

(®) All Connected Calculators () select Caleulators

[[J Replace existing content with the same name on destination calculators

CANCEL SEND

® FILE NAME (NOME FILE): Puo essere diverso dal NAME ON CALCULATOR (NOME
SULLA CALCOLATRICE) a seconda di come ¢ stata denominata la schermata
acquisita sul computer.
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NAME ON CALCULATOR (NOME SULLA CALCOLATRICE): Selezionare I'immagine di
sfondo. Dovrebbe essere I'impostazione predefinita, ma e possibile modificare il
nome dell'immagine di sfondo utilizzando questo menu.

Nota: Le schermate acquisite e i file immagine convertiti verranno inviati come Pic
Var (Variabile Figura) alle calcolatrici in bianco e nero.

GRAPH AREA ONLY (SOLO AREA DEL GRAFICO): Nel pannello di destra, selezionare
se inviare solo |'area del grafico oppure I'intera schermata. Quando si invia di
nuovo alla calcolatrice una schermata acquisita, € consigliabile inviare solo |I'area
del grafico.

Ritaglio di un'immagine

Un'immagine acquisita dell'area del grafico include I'intera schermata della
TI-84 Plus CE, la barra di stato, il bordo del grafico e I'area del grafico.

Il software Tl Connect™ CE consente di ritagliare I'immagine sulle dimensioni della
sola area del grafico per creare una Background Image Var (Variabile Immagine di
sfondo). E possibile ritagliare una schermata in base alla sola area del grafico nella
finestra di dialogo Send to Calculators (Invia a calcolatrici).

W77

LT

.| Graph Area Only | Graph Area Only

DESTINATION CALCULATORS (CALCOLATRICI DI DESTINAZIONE): Selezionare se
inviare I'immagine a tutte le calcolatrici collegate o solo alle calcolatrici
selezionate (da un elenco di selezione).

Per inviare file a piu calcolatrici simultaneamente

1.

2.
3.

Selezionare il pulsante Select Calculators (Seleziona calcolatrici) nella finestra di
dialogo.

Fare clic sulle caselle accanto alle calcolatrici da selezionare.

Fare clic su Send (Invia).

Trascinamento e rilascio di schermate acquisite in applicazioni del
computer

Utilizzando I'area di lavoro Screen Capture (Acquisizione schermata), & possibile
trascinare e rilasciare schermate acquisite in molte applicazioni del computer. Questa
funzione consente di utilizzare le schermate della calcolatrice all'interno dei proprio
documenti.

10 Utilizzo dell'area di lavoro Screen Capture (Acquisizione schermata)



Per trascinare e rilasciare schermate in applicazioni del computer
1. Aprire o acquisire la schermata.

2. Trascinare e rilasciare la schermata in un documento aperto o in un'applicazione
per presentazioni del computer.

Nota: E anche possibile utilizzare Edit>Copy>Paste (Modifica > Copia > Incolla) in un
documento aperto o in un'applicazione per presentazioni del computer.
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Utilizzo dell'area di lavoro Calculator Explorer (Gestione
calcolatrice)

L'area di lavoro Calculator Explorer (Gestione calcolatrice) consente di gestire il
contenuto della calcolatrice.

il

[§]  CONNECTED CALCULATORS (1) TI-B4Plus CE  Archive: 1,807 kB available | RAM: 140 kB available
B % Y ADAD NAME Tree + sze LocaTioN
== @ sciTools Flash Application 54kB Archive
. [ probsim Flash Application 71kB Archive
@ pysmiz Flash Application 88 kB Archive
@ cabrir Flash Application 102 kB Archive
[ celsheet Flash Application 123kB Archive
@ Easypata Flash Application 167 kB Archive
g INNODISC Program 9478 RAM
oo QUADTHEO  Program 2k Archive
oo THEKICK Protected Program 11k RAM
L Real List 28 RAM
L Real List 28 RAM
L Real List 28 RAM
L Real List 28 RAM
L Real List 28 RAM
L Real List 298 RAM
02 v Real Number 98 RAM
012 ¥ 2a3l Number on 2an
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Elementi dell'area di lavoro Calculator Explorer (Gestione
calcolatrice) principale

Barra dei menu - Utilizzare questi menu per gestire i file e le immagini, per
visualizzare i dati della calcolatrice e per ottenere aiuto.

File Edit View Actions Help

Nota: E possibile eseguire la maggior parte delle azioni di questi menu trascinando
e rilasciando elementi dal pannello Contenuto.

Barra degli strumenti - Fare clic su queste icone per aggiungere, trasferire o eliminare
file sulla calcolatrice.

000 0 ©

Aggiunge contenuto dal computer.

Invia contenuto selezionato al computer.

Invia contenuto selezionato ad un'altra calcolatrice collegata.

Elimina il file selezionato.

Aggiorna la vista del contenuto di una calcolatrice collegata.

oyl o>
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Pannello Contenuto - Selezionare i file da gestire da questo pannello.

il
Fle  Edit  View  Actions  Help
&
[§]  CONNECTED CALCULATORS (1) TI-B4Plus CE  Archive: 1,807 kB available | RAM: 140 kB available
B % Y ADAD NAME Tree + sze LocaTioN
== @ sciTools Flash Application 54kB Archive

= [ probsim Flash Application 71kB Archive
D pysmiz Flash Application 33 kB Archive
@ cabrir Flash Application 102 kB Archive
[ celsheet Flash Application 122 kB Archive
[ EasyData Flash Application 167 kB Archive
g INNODISC Program 9478 RAM
Th QUADTHEO  Program 2ke Archive
oo THEKICK Protected Program 11k RAM
) Real List 28 RAM
[ . Real List 28 RAM
[ " Real List 28 RAM
)L Real List 28 RAM
[ Real List 28 RAM
[ Real List 298 RAM
02 v Real Number 98 RAM
012 ¥ 2a3l Number on 2an

Selezione di una calcolatrice collegata

Il software Tl Connect™ CE consente di collegare piu calcolatrici simultaneamente.
Fare clic sulla calcolatrice con cui si desidera lavorare per selezionarla. La calcolatrice
selezionata diventa la calcolatrice predefinita per tutte le azioni del software Tl
Connect™ CE.

Prima di cominciare

Collegare la calcolatrice al computer e accertarsi che sia visualizzata nel pannello
Elenco calcolatici.

Copia di file della calcolatrice sul computer

E possibile copiare la maggior parte dei dati, dei file e dei programmi dalla calcolatrice
sul computer come copie di backup, per inviarli ad altri utenti oppure per liberare
memoria sulla calcolatrice.

Per copiare un file dalla calcolatrice sul computer

1. Fare clic sul nome del file per selezionarlo.

2. Trascinare e rilasciare il file in una cartella sul computer o sul desktop.
Per copiare un file dalla calcolatrice sul computer come backup

1. Selezionare Edit (Modifica)

2. Seleziona All (Tutto)

3. Trascinare e rilasciare il file in una cartella sul computer o sul desktop.
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Nota: Non esiste una funzione di backup automatico.

Avvertenza: Non scollegare il cavo durante un trasferimento.

Per copiare un file dal computer sulla calcolatrice
1. Evidenziare il file desiderato sul computer.

2. Trascinare il file nel pannello Elenco calcolatrici e soffermarsi sulla calcolatrice
desiderata.

Rilasciare il pulsante del mouse quando appare + Copy

Selezionare un nome file dal menu a discesa. Questo sara il nome del file sulla
calcolatrice.

5. Fare clic su Send (Invia).
Invio di file alle calcolatrici collegate

E possibile inviare file alle calcolatrici collegate al software Tl Connect™ CE.

|Awertenza: Non scollegare il cavo durante un trasferimento.

Per inviare file alle calcolatrici collegate

1. Fare clic sul(i) file nel pannello Contenuto per selezionarlo(i).

b
2. Fareclicsu .

f& send to calculators x|

DESTINATION CALCULATORS:

() All Connected Calculators (®) Select Calculators

[V] TI-84 Plus CE-1927

[] TI-84 Plus CE-1BSE

|:I Replace existing content with the same name on destination calculators

CANCEL SEND
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e DESTINATION CALCULATORS (CALCOLATRICI DI DESTINAZIONE): Selezionare se
inviare il file a tutte le calcolatrici collegate o solo alle calcolatrici selezionate (da
un elenco di selezione).

Per inviare file alle calcolatrici selezionate

1. Selezionare il pulsante Select Calculators (Seleziona calcolatrici) nella finestra di
dialogo.

2. Selezionare le caselle accanto alle calcolatrici da selezionare.

3. Fare clic su Send (Invia).
Conversione e invio di immagini di sfondo

La TI1-84 Plus CE puo visualizzare immagini di sfondo e Pic Var (Variabili Figura).
Queste variabili vengono visualizzate nell'area del grafico.

Nota: Tutte le informazioni sulle immagini di sfondo sono valide anche per la TI-84
Plus C Silver Edition e la TI-83 Premium CE.

Operazioni con immagini di sfondo

Il software Tl Connect™ CE converte automaticamente qualsiasi immagine inviata a
una calcolatrice collegata in una Background Image Var (Variabile Immagine di
sfondo). L'immagine puo apparire diversa nell'area del grafico rispetto al previsto a
causa della conversione nel formato 83 x 133 pixel.

Nota: Per risultati ottimali, modificare I'immagine in modo che sia proporzionata
al formato 83 x 133 pixel prima della conversione.

Suggerimento. Provare a convertire I'immagine come descritto sotto. Se la
conversione non ha I’esito previsto, ridurre in scala I'immagine alle dimensioni del
grafico dove sono visualizzate le Var Background Image (Immagine di sfondo) sulla
CE.

e Acquisire I'immagine dello schermo del grafico in scala 100% utilizzando I'area
di lavoro Screen Capture (Acquisisci schermo). Questa acquisizione dello
schermo puo essere in modalita Full (Intera) o Graph-Table (Grafico-Tabella).
La si utilizzera per ridurre in scala 'immagine per adattarla all’area del grafico.

e Utilizzare un software per presentazione a piacimento e visualizzare sia
I’acquisizione dello schermo sia 'immagine.

e Trascinare (ridimensionare) I'immagine per ridurla alle dimensioni dell'area
del grafico.

e Utilizzare uno strumento di ritaglio per tagliare la nuova immagine piu piccola.
Salvare I'immagine sul computer

e Utilizzare questa immagine proporzionalmente pil piccola per convertirla in
una Var Image (Immagine) seguendo i passaggi riportati di seguito.

Promemoria. Conservare I'immagine originale utilizzando un nome del file per
computer differente dell’'immagine piu piccola.

La conversione in Background Image Var (Variabile Immagine di sfondo) utilizza colori
a 16 bit.
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E inoltre possibile caricare una Background Image Var (Variabile Immagine in sfondo)
nella vista emulatore della TI-84 Plus CE nel software TI-SmartView™ CE.

Nella TI-84 Plus CE, una Background Image Var (Variabile Imnmagine di sfondo) appare
come sfondo solo nell'area del grafico. Un'immagine di sfondo viene visualizzata in
scala per le seguenti impostazioni di modalita della schermata: Full (Intero), Horizontal
(Orizzontale) e Graph-Table (Grafico/Tabella). Cid preserva qualunque modellizzazione
matematica eseguita su uno sfondo. Non e possibile modificare un'immagine di
sfondo mentre si utilizza la TI-84 Plus CE. Le immagini di sfondo sono prelevate e
memorizzate nella memoria Archivio.
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Invio di un'immagine di sfondo a una calcolatrice collegata

E possibile inviare un'immagine di sfondo e visualizzarla nell'area del grafico della TI-
84 Plus CE.

Nota: Tutte le informazioni sulle immagini di sfondo sono valide anche per la TI-84
Plus CE-T, la TI-84 Plus C Silver Edition e la TI-83 Premium CE.

NORMAL FLOAT AUTO REAL RADIAN MP n

1. Aprire il software Tl Connect™ CE.

2. Scegliere I'area di lavoro Calculator Explorer (Gestione calcolatrice).

3. Collegare la TI-84 Plus CE al computer utilizzando il cavo.

4. Accendere la TI-84 Plus CE.

5. Scegliere I'immagine da convertire.

6. Trascinare I'immagine nel pannello Elenco calcolatrici e soffermarsi sulla
calcolatrice desiderata.

7. Rilasciare il pulsante del mouse quando appare & Copy

Selezionare un nome ImageN. dal menu a discesa (Image0 - Image9). Questo sara
il nome dell'immagine sulla TI-84 Plus CE.

Nota: Il nome ImageN. scelto diventa il nome dell'immagine sulla calcolatrice.
Annotare questo nome ImageN. (oppure inserirlo nel nome file sul computer) per
identificare il file per I'invio o la condivisione.

AVVERTENZA: Le immagini pre-caricate vengono memorizzate con i nomi Imagel -
Imageb5. Utilizzare altri nomi ImageN. per evitare di sovrascrivere le immagini pre-
caricate.

9. Fare clic su Send (Invia).

Nota: Ridenominare il file del computer in modo da poter identificare la Image Var
(Variabile Immagine) in un successivo momento (ad esempio, ponte, fontana, ecc.). Il
nome della variabile ImageN. interno alla calcolatrice rimane invariato.

Nota: Per salvare I'immagine di sfondo sul computer, trascinare I'immagine ImageN
da Calculator Explorer (Gestione calcolatrice) sul desktop oppure sulla cartella in cui si
intende salvarla.
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e Pervisualizzare la nuova immagine di sfondo nell'area del grafico della
TI-84 Plus CE, premere [format] modificare I'impostazione di Background
(Sfondo) inserendo I'immagine ImageN appena inviata alla calcolatrice (ad
esempio, Image5) e premere [graph].

Nota: Dalla schermata del grafico sulla calcolatrice, & possibile modificare lo
sfondo utilizzando anche il comando interattivo [draw]; BACKGROUND;
1:BackgroundOn.

Importazione dati

La funzione Data Import (Importa dati) consente di convertire/inviare alla calcolatrice
dati di foglio di calcolo salvati in formato .csv come file lista(e) o matrice della
calcolatrice.

Accedere alla funzione Data Import (Importa dati) dall'Area di lavoro Calculator
Explorer (Gestione calcolatrice).

Punti chiave:
e Creare (o scaricare) un foglio di calcolo.

e Prima di eseguire I'importazione, modificare i dati nel programma di foglio
elettronico utilizzato esclusivamente nei formati numerici consentiti dalla
calcolatrice (specificati sotto) per I'importazione in un file della calcolatrice.

Informazioni sul foglio di calcolo

e Tramite |'area di lavoro Calculator Explorer (Gestione calcolatrice) & possibile
importare solo un foglio di calcolo alla volta, salvato in formato CSV (Comma
Delimited) (*.csv).

e |l foglio di calcolo (file .csv) puo essere trascinato nell'area di lavoro Calculator
Explorer (Gestione calcolatrice) o importato tramite Actions > Menu Import Data
(.csv) to List/Matrx... (Azioni > Menu Importa dati (.csv) in lista/matrice).

e Alla calcolatrice collegata verranno inviate fino a 6 liste della calcolatrice o 1
matrice di dati del foglio di calcolo.

Regole per la preparazione del foglio di calcolo per I'importazione:

e Tutte le celle devono contenere dati con numeri reali (riconosciuti come tali dalla
calcolatrice) e non testo.

- I numeri complessi non sono supportati per I'importazione.
e | dati devono iniziare nella cella Al

e Importazione di liste: Se si desidera importare liste della calcolatrice:
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£ Import your Data x|

Prior to importing your spreadshest saved in csv file format, make sure
your data starts in cell A1, contains only Real numeric values, and does
not contain text.

Select calculator file type for conversion:

FILENAME: temp_data.csv

COLUMNS:

{} Lists v 1 v

Up to 6 columns with a maximum of 999 rows each.

CANCEL CONTINUE

- Verrano importate solo sei colonne (A-F) del foglio di calcolo.

- Le colonne possono contenere fino a 999 celle.

- La prima cella vuota in una colonna verra interpreta come la fine dei dati per
I'importazione di quella lista.

e Importazione di matrici: Se si desidera importare matrici della calcolatrice:

& Import your Data x|

Prior to importing your spreadshest saved in csv file format, make sure
your data starts in cell A1, contains only Real numeric values, and does
not contain text.

Select calculator file type for conversion:

FILENAME: temp_data.csv
ROW:  COL: CELLS:
[z:] matrix v 2 (x|2 4

Up to 400 cells

CANCEL CONTINUE

- E possibile importare una sola matrice da un file di foglio di calcolo.

20 Utilizzo dell'area di lavoro Calculator Explorer (Gestione calcolatrice)



- Possono essere importate fino a 400 celle. (Esempio: riga x col: 10 x 5 =50
celle dall'intervallo di righe 1-10, colonne A-E.)

- Le dimensioni della matrice del modulo (riga x colonna) verranno richieste
durante I'importazione in Calculator Explorer (Gestione calcolatrice).

- Qualsiasi cella vuota all'interno delle dimensioni della matrice specificate verra
interpretata come 0.

e |l foglio di calcolo non deve contenere dati esterni alle dimensioni consentite per le
liste o la matrice, come descritto sopra. Diversamente, il file risultera non valido
quando si tentera di eseguire un'importazione di dati in Calculator Explorer
(Gestione calcolatrice).

Per salvare file liste o matrice della calcolatrice

e Persalvare file della calcolatrice creati sul computer, dopo |'importazione/invio
alla calcolatrice, trascinare le liste o il file matrice da Calculator Explorer (Gestione
calcolatrice) nella posizione desiderata sul computer.

Eliminazione di file dalla calcolatrice
E possibile eliminare dati, file e programmi dalla calcolatrice.

Per eliminare file dalla calcolatrice

1. Fare clic sul file da eliminare nel pannello Contenuto.

2. Premere .
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Esci da modalita esame impostazione sul collegato calcolatrici CE

Uscire dall'impostazione Exam Mode (Modalita esame) sulla CE collegando le
calcolatrici CE al computer e selezionando

e Operazioni > Esci da modalita esame su collegato calcolatrici CE in Tl Connect CE.

Promemoria: Utilizzare il Bundle CE piu recente disponibile presso
education.ti.com/84ceupdate per essere certi di disporre sulla CE dei file della
calcolatrice piu aggiornati e appropriati per la TI-84 Plus CE.
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Utilizzo dell'Area di lavoro Program Editor (Editor di
programmi)

L'area di lavoro Program Editor (Editor di programmi) consente di lavorare con
programmi TI-Basic.

&2 11 connect™ ci =[o] x|

New Program
(1]

_|_

Open Program

o
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Elementi dell'area di lavoro Program Editor (Editor di programmi)

e _ ol x|

File  Edit  View

+ =

9 New Program

_|_

Open Program

o

o Barra dei menu - Utilizzare questi menu per gestire i file e i programmi e per
ottenere aiuto.

File Edit M

Nota: Nell'area di lavoro Program Editor (Editor di programmi) & possibile
solamente trascinare e rilasciare programmi nel pannello Contenuto.

9 Barra degli strumenti - Fare clic su queste icone per Creare un nuovo
programma, Aprire un programma, Salvare un programma sul computer, Inviare
un programma alle calcolatrici collegate, Annullare o Ripetere un'azione e
utilizzare il Cursore dimensione carattere.

+ @B ¥ © c e A
06 o (5] (6]

Crea un nuovo programma.

Apre un programma.

o Qe

Salva un programma sul computer.
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® Invia un programma alle calcolatrici collegate.

Annulla o ripete un'azione.

Qo

Cursore dimensione carattere per ingrandire o rimpicciolire la
dimensione del testo nel:

e Pannello Catalogo
e Program Editor (Editor di programmi)

Pannello Contenuto - Utilizzare questo pannello per creare, visualizzare e
modificare programmi.

New Program

_|_

Open Program

-

Pannello Catalogo - Utilizzare questo pannello per selezionare il tipo di
calcolatrice e quindi effettuare le selezioni desiderate dall'elenco ad albero
del Catalogo (per categoria) per creare programmi.
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*» Angle

» Catalog

* Char

* Distribution
* Draw

* Finance

* Format
*List

* Math

* Matrix

» Memory

» Mode

* Program

» Statistics
+ Stat Plots
* Table Setup
* Test

* Variables

» Zoom

Pannello Syntax Reference (Riferimento sintassi) - Utilizzare questo pannello
per visualizzare la sintassi corretta di ogni comando assieme agli argomenti
obbligatori ed opzionali.

Syntax Reference

AsnConmp (prgmASM1,

Creazione di un nuovo programma

Se non ci sono programmi aperti, il pannello Contenuto visualizza solo le icone New
Program (Nuovo programma) e Open Program (Apri programma).

Per creare un nuovo programma

New Program

» Fare clic sull'icona New Program (Nuovo
programma). +

Per aprire un programma esistente open program

1. Fare clic sull'icona Open Program (Apri
programma).

2. Accedere alla cartella appropriata.
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3. Fare clic su Open (Apri).

Modifica di un nome di variabile

| nuovi nomi di programma seguono il modello PROG##. | numeri sono sequenziali, ad
esempio: PROG01, PROGO2.

Per modificare il nome di un programma

> Fare clic all'interno della casella Var Name (Nome variabile) e digitare un nuovo
nome composto da un massimo di 8 lettere o numeri (il primo carattere non puo
essere un numero).

VAR NAME:  PROGO1

Protezione del programma

Il software Tl Connect™ CE consente di proteggere il programma dalle modifiche dopo
che questo e stato inviato a una calcolatrice collegata.

Per proteggere il programma

> Fare clic sulla casella di controllo accanto all'icona con il lucchetto. =
Salvataggio di un programma sul computer
L'asterisco all'inizio del nome di un programma indica che il programma non é salvato.

Per salvare un programma

1. Fareclicsu .

2. Accedere alla cartella appropriata.

3. Fare clic su Save (Salva).
Chiusura di un programma
Per chiudere un programma

» Fare clic sul simbolo x accanto al nome del programma.

Utilizzo dell’Area di lavoro Program Editor (Editor di programmi) 27



Utilizzo del pannello Catalogo

Il pannello Catalogo contiene un elenco di comandi, funzioni, variabili e simboli della
calcolatrice che possono essere utilizzati per creare programmi.

Per espandere o comprimere un livello del Catalogo

» Fare clic sul triangolo accanto ad ogni voce del Catalogo.

TI-84 Plus CE ~ *Untitled1.8xp X

» Keypad

» Angle VAR NAME:  PROGO7
» Catalog

» Char

Distribution
Draw

>
»
» Finance
»
»

Format
List
¥ Math
» Math
» Numeric
» Complex
» Probability
¥ Fraction
I
4D
rnid4rUnid
» Matrix
» Memory
» Mode
» Progran

» Statistics
» Stat Plots
» Table Setup
» Test

» Variables

» Zoom

Synt .eference

No reference available

Per inserire una voce del Catalogo nel pannello Contenuto

» Trascinare e rilasciare la voce del Catalogo nel pannello Contenuto. Cosi facendo il
cursore si posiziona nella riga di comando dell'Editor di programmi, dopo la voce
rilasciata.

Oppure
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> Fare doppio clic sulla voce del Catalogo. Cosi facendo si inserisce la voce nell'editor

di programmi, ma il cursore rimane nel pannello Catalog per consentire la
selezione di un altro elemento. Fare clic alla fine della riga di comando per
continuare a digitare nell'editor.

Per evitare errori di sintassi

Utilizzare il Catalogo dei comandi e dei simboli per inserire comandi e simboli
nell'editor ed evitare errori di sintassi dovuti all'uso errato del minuscolo e del
maiuscolo nella sintassi dei comandi.

Esempio:
E stato digitato Eval( o eval(?

E stato digitato sin( or Sin(?

L'elenco ad albero
del Catalogo TI-84 Plus CE ~ *Untitled L8xp X
inserisce il carattere ;
(maiuscolo/minusco DispBraph

|O) e gll Spazi DispTable VAR NAME: PROGO1
corretti. »YOMS
Dot-Thick
Dot-Thin
DrawF

l 101 evali

Drawlnv
DS<(

e

et

E

PEFT(

Els=

End

Eng
EqukString(

eval(

Execlib

expr(
ExpReg
ExprOff
ExprOn
Fedf(
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Errori di sintassi dovuti a spazi extra
Esecuzione di un programma su una calcolatrice

Gli spazi extra possono causare un errore di sintassi quando si esegue un programma
sulla calcolatrice.

Dove sono gli spazi extra?

E possibile visualizzare gli spazi extra
nel programma utilizzando il Program
Editor (Editor di programmi) di Tl
Connect™ CE e selezionando l'intero
programma. Gli spazi extra alla fine
delle righe di comando dovrebbero
essere cancellati prima di inviare il
programma alla calcolatrice.

VARNAME: SNAKE

Quando il programma € in esecuzione sulla calcolatrice, se ci sono spazi extra,
selezionando Goto (Vai a) dalla schermata dell'errore di sintassi, il cursore verra
posizionato sulla riga del programma in cui si e verificato I'errore. Controllare che nella
riga di comando sia stata inserita la sintassi corretta e che non ci siano spazi extra alla
fine della riga stessa.

VARNAME:  SNAKE

URMAL FLOAT AGTN REAL RADIAN MP
([PROGRAM LINE 11

ERROR: SYNTHX

:Qu-tt ClrHome
FHGoto 13+A
548
184X
1P
344D
Xadin (L1)
sX»dim(L1) Xsdin(L2)

:X+dim(Lz) A
:F111(B,L1) Repes K15
*Fill(A,L2} / 0 PlLz(P)," )
:Repeat KE45S P ST R
AsL2 (P
/ P+1-X(P=X) 4P
tKey-K
Cursor lands on error. 17 ma (K=(24,25,25,34})
K+D
A+ (D=26) - (D=24) A
B+(D=34)- (0=25)+8

A+26( (A=0) - (A=27))-A
B+1@( (B=0)-(B=11))+B
End

e Spostare il cursore alla fine di quella riga di comando.
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e Eliminare gli spazi extra facendo molta attenzione.

Nota: L'azione non puo essere annullata sulla calcolatrice.

MORFAL FLOAT AUTD REAL RADIAM HF n HORMAL FLOAT AUTO REAL RABIAM HF n

PROGRAN LIME 7

PROGRAM: SNRKE PROGRAM : SNAKE
:ClrHome tClrHome
:13+A +134A

:5+B 1548

:1@9X 1 109%
14p 14p Spaces
134D 134D
) |:Xedim(Lal r¥edimila) B
1Xddimilz) s ¥Aadim(lzd
:F1il1(B.L1} :F1il11(B.L1)

Quando i comandi diventano comandi della calcolatrice (token)?

| comandi non diventano tali sulla calcolatrice (token) finché il programma non viene
inviato alla calcolatrice.

Se si verifica un errore quando il programma viene inviato alla calcolatrice o viene
eseguito sulla calcolatrice, verificare che tutti i comandi in modalita Modifica
programma della calcolatrice siano diventati effettivamente dei token.

Come si capisce?

Quando un comando & un token sulla calcolatrice, il cursore posizionato sul primo
carattere si sposta saltando |'intero comando (& un token). Se il cursore si sposta di un
carattere alla volta nel comando, il comando non é stato convertito. Eliminare e
inserire il comando dalla calcolatrice.

PROGRAM: B PROGRAM: B On the calculator, the cursor
nvBinom —) ; L A A
*EnvBinom( dinvBinom(W . 05 over the “token.”
It only understands the
characters as a function or

command name.

Promemoria: Se si introduce un programma direttamente nella calcolatrice, il comando
o la funzione vengono inseriti immediatamente come token.

Avvertenza: Alcuni comandi della calcolatrice, come LEFT, CENTER, RIGHT, FRAC, sono
parole che si potrebbero utilizzare in una stringa. Se una parola utilizzata in una stringa
e uguale a un comando della calcolatrice, la parola diventera un token della
calcolatrice e potrebbe dare luogo a errori nel programma. Evitare di utilizzare parole o
parti di parole uguali a un comando TI-Basic per evitare che vengano
involontariamente trasformate in comando.

Avvertenza: L'impostazione della lingua di TI Connect™ CE determina in che modo il
testo verra interpretato come token della calcolatrice. L'apertura di programmi e il re-
invio alla calcolatrice con Tl Connect™ CE in lingue diverse puo provocare:

e token indesiderati e/o

e errore di sintassi
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Utilizzo del pannello Syntax Reference (Riferimento per la sintassi)

Il pannello Syntax Reference (Riferimento per la sintassi) visualizza la sintassi di ogni
voce del Catalogo, inclusi gli argomenti obbligatori e opzionali.

Syntax Reference

Pt-Change(x,y[,color#])

HUB menu HUB per TI-Innovator™ e TI-Innovator™ Rover

Program Editor (Editor di programmi) supporta il menu TI-Innovator™ HUB per i
comandi TI-Innovator™ e Tl-Innovator™ Rover. Il menu HUB & elencato nel menu
Program (Programmi) nell'elenco ad albero del Catalogo. Questo menu HUB aggiunto
al Program Editor (Editor di programmi) di TI Connect™ CE corrisponde al menu HUB a
cui si accede quando I'App Hub é caricata sulla calcolatrice CE. Utilizzare sempre le
versioni piu aggiornate del SO CE e dell'App Hub CE.

Vedere anche:

Utilizzo del pannello * Frogra
Catalogo

» Comtrol

» Tnput/Output
Invio di un programma a » Colar

una calcolatrice . HUB

» Sond|"SET
» Send( "READ
* Settings
Wait
Get |
eval |
® Rover (RV)...
» Sond( "CONNECT-Output
¥ Send | "CONNECT-Input
¥ Ports
» Send| "RANGE
* Send | "AVERAGE
¢ Send| "DISCONNECT -Output
®» Send| "DISCONNECT-Input
» Hanage

Invio di un programma a una calcolatrice

E possibile inviare un programma a una calcolatrice collegata.
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Per inviare un programma a una calcolatrice collegata

1. Se ancora non é stato fatto, salvare il programma.

2. Fareclicsu X

®  FILE NAME (NOME FILE): Puo essere diverso dal NAME ON CALCULATOR (NOME
SULLA CALCOLATRICE) a seconda di come é stato denominato il programma sul
computer.

e NAME ON CALCULATOR (NOME SULLA CALCOLATRICE): Selezionare il nome del
programma. Dovrebbe essere |'impostazione predefinita, ma & possibile
modificare il nome del programma facendo clic su Custom (Personalizza).

Bl £ Name on Calculator [ESNIEE ]

FILE NAME: NAME O CALCULATOR: LocaTion:

Untitled1 8 PROGO1 - RAM

Qustom
DESTINATION CALCULATORS: Custom Program names can be up to 8 characters in length.

All Connected Calculators. ® Select Calculators. The first character can be A-Z or 8.
The remaining characters can be A-Z, 6 or 0-9
¥ TI-84 Plus CE-ADAD

i Replace existing content with the same name on destination calculators

CANCEL
CANCEL  SEND

e LOCATION (UBICAZIONE): Scegliere se salvare il programma nella RAM o
nell'Archivio della calcolatrice.

e DESTINATION CALCULATORS (CALCOLATRICI DI DESTINAZIONE): Selezionare se
inviare il programma a tutte le calcolatrici collegate o solo alle calcolatrici
selezionate (da un elenco di selezione).

Per inviare un programma a piu calcolatrici contemporaneamente

1. Selezionare il pulsante Select Calculators (Seleziona calcolatrici) nella finestra di
dialogo.

2. Fare clic sulle caselle accanto alle calcolatrici da selezionare.
3. Fare clic su Send (Invia).

Impostazioni della lingua

Se si desidera sviluppare un programma Tl-Basic in una lingua diversa dalla lingua del
SO impostata sul computer, € possibile riavviare Tl Connect™ CE in un'altra lingua.

1. Selezionare File > Change Language (File > Cambia lingua).

2. Selezionare la modifica della lingua dopo il riawio dell'applicazione.
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=2 Choose a language | = x|

Language changes will take effect after application restart.

English (US) hd

QUIT LATER QUIT NOW CANCEL

e QUIT LATER (CHIUDI DOPO) - Mantiene la lingua selezionata e al successivo awio
Tl Connect™ CE funzionera in questa lingua selezionata.

e Fare clic su QUIT NOW (Chiudi ora) - Chiude I'app software. Al successivo awvio Tl
Connect™ CE funzionera in questa lingua selezionata.

e CANCEL (ANNULLA) - Nessuna variazione della lingua. La lingua del SO del
computer sara la lingua predefinita.
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Gestione e aggiornamento della calcolatrice

Aggiornamento del sistema operativo della calcolatrice

Il software Tl Connect™ CE consente di scaricare i sistemi operativi delle calcolatrici
grafiche.

Prima di cominciare
e Fare un backup dei file della calcolatrice (RAM, Archivio e App).
e Accertarsi che la calcolatrice sia accesa e collegata saldamente al computer.

e Se ci sono pil calcolatrici collegate al computer mediante cavi USB, il SO puo
essere trasferito su calcolatrici specifiche.

Per fare cio, selezionare le calcolatrici di destinazione nella finestra di dialogo Send
(Invia).

|Awertenza: Non scollegare il cavo durante un trasferimento.

Per aggiornare i sistemi operativi delle calcolatrici

1. Fare clic su Actions > Send OS (Azioni > Invia SO).

2. Evidenziare il file del SO corretto per il modello di calcolatrice memorizzato sul
computer.

3. Fare clic su Open (Apri).

Viene visualizzata la finestra di dialogo Send OS (Invia SO).

& send 0s x|
05 File:
T-84_Plus_CE-05-5.2.1.0058.8eu

WARNING: Sending the OS5 will clear the memeory on the destination calculators,
but archived items (apps. background images, etc.) will not be erased. Do you want
to send the OS5 now?

DESTINATION CALCULATORS:

(©) All Connected Calculators (8) Select Calculators

[V] T1-84 Plus CE-ADAD
[¥/] TI-84 Plus CE-1927

[¥] TI-e4 Plus CE-1B5E

[] Replace existing content with the same name on destination calculators

CANCEL SEND
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4. Selezionare le calcolatrici di destinazione in Destination Calculators (Calcolatrici di
destinazione):

DESTINATION CALCULATORS:

(O all Connected Calculators (=) select Calculators

(V] TI-84 Plus CE-ADAD
(/] TI-84 Plus CE-1B5E

(V] TI-84 Plus CE-1927

5. Premere Send (Invia) e

Tl File TI CE Bundle — Utilizzate un solo file del computer per
aggiornare la calcolatrice CE!
Aggiornate le calcolatrici CE collegate in un solo passaggio utilizzato Tl Connect™ CE e

il nuovo TI CE Bundle scaricati da education.ti.com/84ceupdate. Scaricate sempre
I'ultima versione di TI CE Bundle da education.ti.com/84ceupdate.

Collegate le calcolatrici CE a Tl Connect™ CE. Trascinate il TI CE Bundle appropriato su
Calculator Explorer (Gestione calcolatrice).

e TI-84 Plus CE/CE-T: TI84CEBundle-x.x.x.xxxx.b84

Tl Connect™ CE aggiornera il SO CE, tutte le App CE che necessitano di aggiornamento
o che non sono presenti sulle calcolatrici e carichera inoltre le 5 Var Immagine
precaricate con i nomi Imagel — Image5. Il processo non puo essere arrestato, e
opportuno quindi assicurarsi di salvare (mediante trascinamento) i file della
calcolatrice preferiti utilizzando Calculator Explorer (Gestione calcolatrice) di Tl
Connect™ CE. E possibile ri-trascinare sulla calcolatrice i file preferiti salvati al termine
dell'elaborazione del nuovo TI CE Bundle.

Trascinare il CE Bundle su Calculator Explorer (Gestione calcolatrice). Attendere il
completamento del processo. Non scollegare il cavo durante il trasferimento di file.
Attendere il riawio della calcolatrice CE prima di trasferire Var Immagine e App.
Attendere che si completi la deframmentazione (ridisposizione della memoria) della
calcolatrice CE durante il processo. Nella finestra Tl Connect CE verranno visualizzati
dei messaggi di notifica del trasferimento.

Nota: non confondere il file TI CE Bundle con i file del SO CE e delle App CE che sono
sempre disponibili per il download separatamente su education.ti.com. Il TI CE Bundle
contiene tutti i file piu recenti necessari per I'aggiornamento o il ripristino della
calcolatrice CE allo stato iniziale, inoltre rappresenta un metodo rapido per aggiornare
il set di calcolatrici CE della classe.

Importante: se sullo schermo della calcolatrice appare "Waiting..." (Attendere...) la
calcolatrice ha perso il SO. Questo puo succedere se viene staccato il cavo dalla
calcolatrice o dal computer durante un trasferimento di file. Se il cavo & in posizione,
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scollegare e ricollegare la calcolatrice CE al computer. Trascinare il CE Bundle su
Calculator Explorer (Gestione calcolatrice).

Promemoria: attendere il completamento del processo . Non scollegare il cavo durante
il trasferimento di file. Attendere il riavio della calcolatrice CE prima di trasferire Var
Immagine e App. Attendere che si completi la deframmentazione (ridisposizione della
memoria) della calcolatrice CE durante il processo. Nella finestra TI Connect CE
verranno visualizzati dei messaggi di notifica del trasferimento.

E possibile ripetere questo processo; CE Bundle trasferira nuovamente i file. Non
scollegare il cavo durante il trasferimento di file.

Vedere anche:
Aggiornamento del sistema operativo della calcolatrice

Invio di file alle calcolatrici collegate

Visualizzazione delle informazioni relative alla calcolatrice

Il software Tl Connect™ CE consente di ottenere informazioni sul tipo di calcolatrice,
I'ID prodotto, la versione SO, la memoria RAM, la memoria Archivio, la lingua, la
versione ROM e la versione hardware.

Nota: Le informazioni sulla calcolatrice sono disponibili solo dall'area di lavoro
Calculator Explorer (Gestione calcolatrice).

Per visualizzare le informazioni relative alla calcolatrice

> Fare clic su View > Calculator Information (Visualizza > Informazioni sulla
calcolatrice).
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=2 Calculator Information x

Calculator: TI-84 Plus CE
Product ID:

_____ 0S5 Version:
RAM:

Archive:

Language:

ROM Version:

Hardware Version:

CLOSE

Compatibilita con calcolatrici grafiche

Per ulteriori informazioni, vedere la Guida introduttiva TI-84 Plus CE per la
compatibilita con calcolatrici grafiche.

Applicazioni, sistemi operativi e alcuni file di dati con tipi numerici non supportati non
condividere tra i modelli.

| programmi TI-Basic debba essere modificato per visualizzare correttamente sui
display a colori i modelli superiori di risoluzione.
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Informazioni di carattere generale

Assistenza on line

education.ti.com/eguide

Selezionare il proprio Paese per ulteriori informazioni sul prodotto.

Per contattare il supporto TI

education.ti.com/ti-cares

Selezionare il proprio Paese per le risorse di supporto tecnico e di altro tipo.

Informazioni su assistenza e garanzia

education.ti.com/warranty

Selezionare il proprio Paese per informazioni sulla durata e i termini della garanzia o
per informazioni sui servizi per i prodotti.

Garanzia limitata. La presente garanzia non pregiudica i diritti spettanti per legge.
Aggiornamenti
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